
                                                                 
 

                                                                                                      EndNote 9 for the PC  
 
 
EndNote 9 is a database that contains specific references you create. It assists in keeping track of references, 
which can be retrieved using search terms.  Bibliographies can be generated in a variety of style formats.  

This product is available to PNNL staff only. 

   
https://library.pnl.gov/tipsheet/endnote9.pdf

 
Installing EndNote 9 
1. From the PNNL Installer, select the Core Apps tab, double click the Other Utilities folder and then double click the 

Bibliographic Management Systems folder.   
2. Select EndNote 9, click Install and follow the instructions on the screen to complete installation. 

 
Creating a Library 
1. When opening EndNote 9 a pop-up window will appear. Click the Create a new EndNote library radio button, and 

then click OK. Or,  
2. If already in EndNote 9 select File and then New from the menu bar. You will be prompted to name and save your 

new library. In the File name box, type the desired file name and click Save. The file type extension is .enl.   A New 
Reference Library window will appear.  Note: The new library may be installed anywhere on your hard drive. 

 
Opening an Existing Library 
1. When opening EndNote 9 click the Open an existing EndNote library radio button from the EndNote 9 pop-up 

window, and select the desired library from the drop-down menu (or use the Browse button). Click OK.  Or,  
2. If already in EndNote 9, select File, Open, and then Open Library. Select the desired library and click Open. 
 
Adding Records to a Library 
Option 1: Entering Records via EndNote Connection Files (e.g., PubMed) 
Searching a Connection File site such as PubMed allows users to use the EndNote 9 interface to run your search. 
Other Connection Files available in EndNote 9 include a large number of library catalogs across the country or 
subscription databases. Using the EndNote 9 interface, users can select and then search these catalogs in one search. 
1. Select Tools from the menu bar, and then select Connect, or click the Connect icon ( ).  A Choose a 

Connection File screen will appear.  
2. Scroll down to PubMed and click Connect. A Remote Search PubMed window will appear. 
3. Input the desired search term(s).  Use the drop down menu to select the desired field. If using a second field, select 

the appropriate connector (AND, OR, or NOT), the desired field and input the second search term.  Note: If more 
than three search fields are needed, click the More arrow and then Add Field. 

4. Click the Search button. A Confirm Remote Search window will appear stating the number of records found. Click 
OK to retrieve these records or specify a range of records to retrieve, and then click OK to download the references.  
At this point, your downloaded references are contained only in a temporary EndNote 9 library.  

5. To move references into the desired library, click the Copy All References To button on the upper right corner of 
the screen. Note: To download a portion of the references obtained by the search, press the CTRL key and then 
click the references of interest to select the desired records. 

6. Select either New Library or Choose Library as the destination for your selected references. References are then 
copied and saved into the selected library. 

 
Option 2: Entering Records Manually 
1. Open the desired library (See the Opening an Existing Library section of this tip sheet). 
2. From the menu bar, select References, and then pick New Reference. 
3. From the Reference Type drop-down menu, select the appropriate work form (e.g., abstract, report, journal, etc.). 
4. Input the applicable data into the work form. Note:  Because of the different indexes EndNote 9 creates with the 

data, cutting and pasting data into the forms is not an option for many of the fields (author, journal name, keywords). 
5. Select File and Save from the menu bar to save the record into the desired library. 

 
 
 

Data Entry Tips 
 Authors’ names can be entered either as First Middle Last (e.g., Ronald Scott Smith) or Last, First Middle  (e.g.,  

  Smith, Ronald Scott).  You must enter each author name on a separate line. Use a hard return to go to the next line.
 Keywords must be separated by a semicolon (;), backslash (\), or hard return.
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Option 3: Entering Records by Importing Search Results 
If you perform a search in databases that provide results in a tagged format (e.g., Dialog, STN, etc.), you can 
import these results into an EndNote 9 library by using an import filter.  If the database used does not offer a 
tagged format for results (i.e., a plain text format that provides the name or “tag” for each field of information), they 
cannot be imported into EndNote 9, but instead will have to be manually entered into a library.  
 
1. Open the desired library (see the Opening an Existing Library section of this tip sheet). 
2. From the File menu bar, choose Import. 
3. Click the Choose File button to locate and open the file you wish to import. With the exception of files from other 

EndNote libraries, all files must be ANSI or ASCII text files. Select the file and click Open. 
4. Select an Import Option by choosing the filter for the database from which you obtained the records. Note: Select 

Other Filters to view additional import filters. 
5. Select an option from the Duplicates list. You can either import all records, discard duplicate records, or have the 

duplicate records sent to their own library for further evaluation.  
6. Click the Import button.  The imported records are imported into the open library.   
Note:  The filters can be unreliable. Be sure to check that your references imported correctly. 
 
Option 4: Direct Imports from Databases 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Web of Science,  BIOSIS Previews or Current Contents Connect 
The Institute for Scientific Information (ISI) created an easy plug-in feature to allow easy export of records from 
the Web of Science or BIOSIS Previews databases into EndNote.  
1. After marking records in the Web of Science database, click Submit Marks, and then click the Marked List 
      button located at the top of the screen. 
2. Select the desired field(s) to include with your references. 
3. Click the Export to Reference Software button and select the appropriate library for the records when  

prompted.  The records will automatically be added to the library. 
 
Tip sheets are available on how to use Web of Science, BIOSIS Previews or Current Contents Connect can be 
found at: https://library.pnl.gov/tipsheet/index.asp.  

 
 

 
 
 
 
 
 
 
 

Compendex or INSPEC 
After performing your search in the Compendex or Inspec databases marking the desired records, and  
choosing the format of the records, click the Download button. From the pop-up window, select RIS, EndNote, 
ProCite, Reference Manager. A second window opens that allows you to select an existing database or create a
one by typing in a new name.   
 
Tip sheets are available for the Compendex and Inspec databases Previews can be found at:  
https://library.pnl.gov/tipsheet/index.asp.  

 
ERICA to EndNote 
1. Set up your search in ERICA, and click the Results Format link.  
2. Select Bibliographic Format (RIS), and then click the Search/Report button. 
3. Click Open from the File Download window and select the appropriate library for the records when  
       prompted. 
 
Be sure to check that your references imported correctly. 
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Customizing the Reference List Display 
The default fields that are displayed in the EndNote 9 library are Author, Year, Title and URL. 
1. Select Edit from the menu bar, and then select Preferences. 
2. Select Display Fields from the list of preferences.  
3. From the drop down menus in the Field boxes, select the desired field(s). Change the Heading, as desired, 

and then click OK. The newly added field(s) is now displayed in the reference list. 
 
Creating a Bibliography of all References in a Library 
Open the desired EndNote Library. 
1. First, select an Output Style for your bibliography: 

a. From the Edit menu, select Output Styles, and then Open Style Manager.  
b. In the EndNotes Style screen, click the checkboxes next to the desired style(s), and then close the 

screen.   Note: If your style is not available, modify an existing style by using the Style Manager.   
c. Again, select Edit, Output Styles.  The submenu will contain a list of output styles you selected in 

Step 3.  Select the desired style. 
2. Next, create the bibliography: 

a. Click File and select Export. Input a file name, then select Rich Text Format (*rtf) as the file type. 
b. Click Save to save the file in the desired directory. 

3. To view the bibliography, open the document in your word processing software (e.g., Microsoft Word). 
 

Create a Subject Bibliography 
Open the desired EndNote library. 
1. From the Tools menu, select Subject Bibliography to display a list of EndNote fields. 
2. Highlight the field(s) whose contents you wish to use as subject headings and then click OK to display the terms 

found in the selected fields.  
3. Select the desired terms.  To quickly select or clear all terms, use the buttons to the right of the dialog window.  
4. Click OK to format the subject bibliography on the screen. To modify the term selections, to either add or remove 

terms from the selected field(s), click the Terms button. NOTE: Subject headings print as they appear in your 
records. No special formatting of author names and no journal title substitution is applied.  

5. Click the Layout button to modify the layout and style of the subject bibliography.  
Once the subject bibliography is formatted, use the Print or Print Preview buttons to print the document or click the 
Save button at the bottom of the screen to save the file.   
 
Using the Cite While You Write Function 
The Cite While You Write function allows you to link references from your library listings in EndNote 9 to a word 
processing document, and also generates notes and bibliographies in specified formats. Note: After downloading 
EndNote 9 for the first time, you may need to restart your computer to obtain the toolbar function. 
 
1. Open Microsoft Word and EndNote 9 
2. Select View from the menu bar, and then Toolbars to select the EndNote toolbar (this will create a toolbar 

of the Cite While You Write functions) or access these functions under Tools, EndNote 9 on the menu bar. 

3. When ready to cite an article in the document you are generating, click the Find Citation icon (  ). 
An EndNote Insert Citation screen will appear. 

4. In the Find box, type in any identifying text to pinpoint the item you wish to cite, and then click Insert.  If 
more than one item is retrieved, a list will appear. Select the appropriate item from the list and click Insert. 
The Word document will automatically format into the latest style selected. 

Note:  To disable Instant Formatting, click the Cite While You Write Preferences Icon ( ). The cited 
references will then appear in a generic format until a style for the document has been selected.   

5. To create the bibliography, select the Format Bibliography icon ( ). 
6. From the EndNote Format Bibliography pop-up window, select an output style (use the Browse button for 

assistance). Note: The remaining options will default to the selected output style, though changes can be 
made manually, if desired.  

7. Once the output style is selected, click OK. The document will be reformatted to place the notes and 
references in the appropriate style. 

 
 
 

For additional information on EndNote, see http://infosource.pnl.gov/software/Bibliographic/default.htm. 
For additional assistance, contact the Hanford Technical Library Reference Desk at 509/ 372-7430. 
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